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Installation

This document provides instructions for the initial installation of the Thermo 
Scientific Dionex ICS-2100 Ion Chromatography System.

NOTE The order of the steps is important. It is especially
important to install the Thermo Scientific Dionex™

Chromeleon™ Chromatography Data System before
connecting the USB cable and turning on the system
power.

1. Facility Requirements

• Make sure the installation site meets these environmental specifications:

Main Power: 100 to 240 Vac, 50 to 60 Hz (Auto-sensing power supply; no 
manual voltage or frequency adjustment required)

Operating Temperature: 4 to 40 °C (40 to 104 °F)

Humidity: 5% to 95% relative humidity, noncondensing

• Provide a sturdy workbench for the system of a height that ensures convenient 
access to the interior of the Dionex ICS-2100.

• Allow at least 15 cm (6 in) behind the system for power connections and 
ventilation. For optimal performance, install the system in a draft-free 
location, out of the path of air conditioning and heating vents.

• Use ASTM filtered, Type I (18-megohm) deionized water when preparing 
eluent and regenerant.

• (Optional) For pressurization of the eluent reservoir, provide a clean gas 
source regulated to between 0.55 and 0.83 MPa (80 and 120 psi). An air 
regulator accessory (P/N 060054) is required to regulate the pressure to 
between 0.03 and 0.04 MPa (5 and 6 psi).

Do not pressurize the eluent reservoir above 0.07 MPa (10 psi).
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2. Unpacking the IC System

1. Open the shipping box (see 
Figure 1) and remove the top 
layer of foam.

Figure 1.  Unpacking the Dionex ICS-2100

2. Open the plastic bag that 
covers the IC system (see 
Figure 2).

Figure 2.  IC System Enclosed in Bag

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über
0,07 MPa aus. 

 (Remove this foam)

Eluent
Bottle

EGC Holder
(upside down)
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3. Set the eluent bottle on top of 
the Dionex ICS-2100 (see 
Figure 3).

4. TURN OVER THE 
DIONEX EGC HOLDER, 
and set it on top of the Dionex 
ICS-2100.

Figure 3.  Dionex ICS-2100 after 
Installing Eluent Bottle and Dionex 

EGC Holder

5. Remove the next layer of 
foam and remove the Ship Kit 
(P/N 064375) (see Figure 4).

6. The bottom layer of foam has 
two cutouts on either side of 
the module; use these as 
handholds when lifting the IC 
system. 

Figure 4.  IC System with Ship Kit

7. Lift the IC system off the bottom layer of foam and out of the box. Set it on a 
workbench.

Two or more persons should lift the IC system, which weighs 30 kg
(66 lb). Lift the IC system only from each side of the cabinet bottom.
Lifting from the front door will damage the door hinges.

Dionex EGC
Holder

(right-side up)

Ship 
Kit
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8. Inspect the system for any shipping damage. Remember to save the shipping 
container and all packing material. You will need them in future if the IC 
system is shipped.

3. Connecting an Autosampler (Optional)

To connect a Thermo Scientific Dionex AS-DV Autosampler or Dionex AS 
Autosampler to the injection valve in the IC system, follow the instructions in the 
appropriate section below.

Notes:

• If an optional auxiliary valve is installed in the Dionex ICS-2100, it can be 
used as the injection valve, instead of the standard valve configured with each 
system. After connecting the autosampler to the auxiliary valve (as described 
in the appropriate section below), configure the valve as the injection valve in 
Chromeleon. For instructions, refer to Installing the Thermo Scientific Dionex 
ICS-1100/1600/2100 Auxiliary Valve (Document No. 065288). The document 
is provided with the valve.

• To connect a Thermo Scientific Dionex AS-HV Autosampler, refer to the 
instructions in Thermo Scientific Dionex AS-HV Operator’s Manual 
(Document No. 065125). The manual is provided on the Thermo Scientific 
Reference Library DVD (P/N 053891).

3.1 Connecting a Dionex AS-DV Autosampler

1. Place the Dionex AS-DV to the left of the IC system on the 
workbench. 

2. Open the IC system and the autosampler doors.

Au moins deux personnes peuvent soulever le chromatograph
ionique:  il pèse 30 kg (66  lb). Ne soulevez le chromatograph ionique
que par chaque côté du fond de l'armoire. Son soulèvement par la
porte du panneau avant endommagera les charnières de la porte.

Das IC system wiegt über 30 kg. Daher sollte das Gerät nur von zwei
oder mehr Personen angehoben werden. Greifen Sie dazu an beiden
Seiten unter das Gerät. Heben Sie den Ionenchromatographen nicht
an der Vordertür an, da dadurch die Türangeln beschädigt werden
könnten.
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3. Route the sample outlet line 
from the Dionex AS-DV 
through the left side slot, at 
the front of the IC system.

4. Connect the outlet sample 
line from the Dionex AS-
DV to port S (5) on the 
injection valve (see 
Figure 5).

Figure 5.  IC System Injection Valve

3.2 Connecting a Dionex AS Autosampler

NOTE Thermo Scientific recommends using AS models
that do not have injection valves. If a valve is
installed in the autosampler, it is switched at the
same time as the valve in the IC system. This causes
unnecessary wear on the autosampler valve. If your
AS has an injection valve, contact Thermo Scientific
for assistance. 

1. Place the autosampler to the left of the IC system on the workbench. 

2. Open the IC system and the autosampler doors.

3. Route the needle seal line that extends from the autosampler inject 
port through the autosampler right side slot (see Figure 6) and then 
through the IC system left side slot to the injection valve.

Dionex AS-
DV Sample
Outlet Line
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4. Connect the needle seal line to port S (5) on the injection valve (see Figure 7).

A coupler (see Figure 8) connects the green waste line from port W (6) to a 
3-mm (1/8-in) ID PTFE waste line. The waste line is routed through the 
tubing chase to the IC system rear panel.

Figure 6.  AS Drip Tray and Right Side Slot

The needle seal line from the AS inject port to the IC system injection
valve is specially constructed. It consists of two tubes (one inside the
other) that are sealed at the end. This seal must be maintained. 

In addition, the line is calibrated for use with the IC system. To ensure
correct autosampler function, this line MUST NOT BE CUT! If
replacement is required, refer to the AS operator’s manual for the
required part number and replacement instructions.

Figure 7.   Injection Valve

Insert the waste line 
from the IC system 
injection valve here

Route the autosampler 
needle seal line to the 
injection valve inside 
the IC system

Autosampler
Needle Seal

Line

Waste
Line



Connecting an Autosampler (Optional)

Doc. 065294-03 10/12 7

5. If the coupler is not visible, grasp the green waste line where it exits the 
tubing chase and pull it toward the front of the system until the coupler is 
outside the chase.

6. Disconnect the green waste line (labeled TO AS50 TRAY) from the coupler and 
route the line to the drip tray in the autosampler compartment.

You can either leave the disconnected PTFE waste line and coupler in the 
tubing chase, or pull the line out from the front.

7. Bend the green waste line about 5 mm (0.2 in) from the end (to ensure it stays 
in the AS drip tray). When bending the tubing, be sure not to restrict the inner 
diameter.

8. Push the end of the green waste line into the small round opening on the right 
side of the AS tray (see Figure 6).

NOTE After the AS is configured for use with the Dionex
ICS-2100 (see Section 12.2), all AS injection types
are supported. In addition, all injection valve
commands (whether issued from Chromeleon or the
AS front panel) can control the injection valve.

Figure 8.  Injection Valve Waste Line Coupler

Make sure the injection valve waste line is not elevated above the
injection valve at any point between the valve and the autosampler
drip tray. 

Coupler

Green 
Waste
Line
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4. Unpacking the PC

1. Remove the PC and all documentation from the PC box and place them on a 
workbench.

2. Follow the instructions in the PC installation guide to connect the PC 
components.

5. Installing Chromeleon

NOTE If you purchased Chromeleon and a PC from Thermo
Scientific, omit this section and go directly to “Starting
the Chromeleon Server” on page 12.

1. To verify that the PC meets current system specifications, go to 
http://www.thermoscientific.com/dionex, select Software under Products, 
and click the Specifications link. 

2. Verify that the Chromeleon disk contains Chromeleon version 6.80 SR6a (or 
later). 

3. For a local PC: Log onto Windows® XP or Windows® Vista® as an 
administrator. 

For a network PC: Log on as a user with local PC administrator privileges.

4. Verify that at least 250 MB of free disk space is available on the drive on 
which you plan to install Chromeleon.

More than 250 MB may be needed to store the large amounts of data that 
Chromeleon can generate. Data can also be stored at a different location (for 
example, on a network).

5. Insert the Chromeleon disk into the PC drive. 

The Chromeleon Setup screen appears. 

6. If you are installing Chromeleon on a PC that has an earlier release of 
Chromeleon 6.80 already installed, click Update Chromeleon and follow the 
on-screen instructions.

http://www.thermoscientific.com/dionex
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7. If you are installing Chromeleon on a PC that does not have an earlier release 
of Chromeleon 6.80 installed, follow these steps to install Chromeleon:

a. On the Chromeleon Setup screen, click Exit.

b. Go to the following folder on the Chromeleon disk: CM680SRx (where x 
is the service release number). For example, if you are installing 
Chromeleon 6.80 SR6a, go to the CM680SR6a folder on the disk.

c. Double-click setup.exe and follow the on-screen instructions.

8. When asked whether to add the Server Monitor program to the Startup group, 
select Yes if the PC will be physically connected to devices or No if the PC 
will never be connected to devices.

9. After installing the software, restart the PC.
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6. Installing the Chromeleon Software License Dongle

NOTE If your software license is provided through a
Chromeleon License Server, omit this section. Instead,
follow the instructions in the Chromeleon Help to install
the software license. Then, go on to “Connecting to the
Chromeleon PC” on page 13.

1. If your software license is issued with a USB dongle, plug the dongle into a 
USB port on the PC. Always connect the USB dongle to the PC, not to a 
Dionex module.

Microsoft® Windows automatically detects the USB dongle and launches the 
Found New Hardware Wizard (see Figure 9). 

2. Complete the wizard by selecting the following options: 

• If asked whether Windows can connect to Windows Update to search for 
software, select No, not this time.

• Accept the default option (Install the software automatically 
(Recommended) option and click Next >. It is not necessary to insert a 

Figure 9.  Windows Found New Hardware Wizard
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hardware installation disk. When the wizard has completed installing the 
software, click Finish.

3. Store the Chromeleon disk in a safe place, away from heat and moisture.

7. Installing the Software License

To activate the licensed features in Chromeleon, enter the license key code (an 
alphanumeric series) provided on the Software License key code sheet. Store the 
key code sheet in a safe place.

1. Click Start on the Windows taskbar and select All Programs > Chromeleon 
> Chromeleon to start the Chromeleon client.

2. Select Help > About Chromeleon.

3. Click the Preferences button and select the License tab (see Figure 10).

4. Under Copy Protection Location, select Dongle and then enter the key code, 
exactly as it appears on the key code sheet. Click OK. 

Figure 10.  Chromeleon License
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5. The About Chromeleon Client screen should now display the serial number of 
the dongle, and all purchased license features (devices controlled, number of 
timebases, and software options) should be labeled On. 

6. Click OK to close the screen.

8. Starting the Chromeleon Server

Check the Chromeleon Server icon on the Windows taskbar to determine if the 
server is already running:

• If the icon is crossed out in red , the server is not running. Right-click the 
icon and select Start Server. 

• If the icon is gray , the server is already running.

If the Server Monitor icon is not on the Windows taskbar, follow these steps to 
start the Chromeleon server:

1. Click Start on the Windows taskbar and select All Programs > Chromeleon 
> Server Monitor. 

The Server Monitor window appears.

2. Click Start to start the server. 

3. Click Close to close the Server Monitor window. 

The Server Monitor icon appears on the taskbar.

NOTE Clicking the Quit Monitor button quits (or exits) the
Server Monitor program, but does not stop the server.
To stop the server, click the Stop button.

Figure 11.  Server Not Running
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9. Connecting to the Chromeleon PC

The IC system rear panel provides a USB receptacle for connecting to a USB port 
on the Chromeleon PC. The rear panel also provides two USB ports for 
connecting other Dionex USB-compliant modules to the system. 

9.1 Connecting the IC System to the PC

1. Locate the USB cable (P/N 960779) in the IC system Ship Kit.

2. Plug the cable’s “A” connector into a USB port on the Chromeleon 
PC and plug the cable’s “B” connector into the USB receptacle 
(labeled FROM PC) on the IC system rear panel (see Figure 12).

Do not turn on the power to the Dionex ICS-2100 or other USB
module(s) until after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed.
If not, Windows will be unable to identify the new USB device when
the power is turned on. To install Chromeleon, see Section 5. 

Figure 12.  Example USB Connections: One IC System Connected to the PC

USB Cable

A

B

IC 
System

PC 
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9.2 Connecting Additional USB Devices

Two USB ports on the IC system rear panel are provided for connecting 
additional Dionex USB-compliant modules (for example, an autosampler) 
to the system.

To connect an additional USB module, plug the “A” connector on a USB 
cable into an “A” port (labeled TO MODULE) on the Dionex ICS-2100 rear 

Figure 13.  IC System Rear Panel

FROM PC 
USB Receptacle

TO MODULE 
USB Ports

Power
Switch
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panel (see Figure 13) and plug the cable’s “B” connector into the USB 
receptacle on the other USB module (see Figure 14).

A USB 2.0 external hub can be used to connect the modules to the PC. 
Refer to the manual provided by the hub vendor for complete installation 
instructions. One or more hubs is required in the following situations:

• Use a hub if the number of USB devices in the system exceeds the 
number of available USB ports.

• Use a hub if the IC system or other USB device is more than 5 meters 
(16 ft) from the PC. 

 

Figure 14.  Example USB Connections: Two Dionex USB Modules 
Connected to the IC System

The USB standard limits the USB cable length to 5 meters (16 ft). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters
(32 yds) from the PC.

A

B

A

A

B B

IC
System

PCChromeleon 

Dionex
USB 

Module

USB Cables

Dionex
USB 

Module
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10. Connecting the Power Cord

1. Verify that the main power switch on the rear panel of the Dionex ICS-2100 
(see Figure 13) is turned off. (The main power switch may be turned on 
accidentally when the module is unpacked.)

2. Connect the power cord (IEC 320 C13) (ordered separately) from the main 
power receptacle on the rear panel to a grounded power source. The IC system 
power supply is auto-sensing, so no adjustment is required to select the line 
voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the IC system or connect it to AC power
mains without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the IC system and is easily
accessible. 

Operation at AC input levels outside of the specified operating voltage
range may damage the IC system.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.

Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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11. Installing the Dionex ICS-2100 Device Driver

1. If you have not already done so, turn on the PC power.

2. For a local PC: Log onto Windows XP or Windows Vista as an 
administrator. 

For a network PC: Log on as a user with local PC administrator privileges.

3. If the Chromeleon Server is not running, start the server (see Section 8). 

4. Press the power switch on the Dionex ICS-2100 rear panel (see Figure 13) to 
turn on the power. 

5. Turn on the power to the autosampler (if installed).

6. Windows automatically detects the new USB devices. A message flashes on 
the screen to inform you that new hardware was found. 

The Found New Hardware Wizard appears (see Figure 15). This wizard 
installs the new hardware into the Windows Device Manager. 

Before turning on the system power, verify that Chromeleon software
is installed. If Chromeleon is not installed first, Windows will be
unable to identify the new USB device. For Chromeleon installation
instructions, see Section 5. 

Figure 15.  Windows Found New Hardware Wizard: IC System Device
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7. Complete the wizard for each new device by selecting the following options:

• If asked whether Windows can connect to Windows Update to search for 
software, select No, not this time.

• Accept the default option (Install the software automatically) and click 
Next >. It is not necessary to insert a hardware installation disk.

8. If any additional devices were found (for example, an autosampler), complete 
the wizard for the device.

12. Setting Up Chromeleon

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon Help.

12.1 Creating a Timebase

1. Click Start on the Windows taskbar and click All Programs > 
Chromeleon > Server Configuration to start the Chromeleon Server 
Configuration program.

2. Select Edit > Add Timebase. 

The New Timebase dialog box appears.

3. Type a name for the timebase (for example, ICS-1100) (see 
Figure 16).

Figure 16.  Example New Timebase Dialog Box
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4. (Optional) Select the Create Folder Structure for Your Data check 
box. This creates a standardized folder structure in the Chromeleon 
Browser for the data related to your timebase.

5. Click OK.

The new timebase appears under the server name.

6. Right-click the new timebase and select Add Device. 

The Add device to timebase dialog box appears.

7. Under Manufacturers, select Dionex IC: Integrated Systems.

8. Under Devices, select ICS-1100 and click OK.

The Properties dialog box for the IC system appears. The General tab 
page shows the Device Name (Pump_ECD) and the Mode (Live).

Figure 17.  Example Server Configuration with New Timebase
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9. Click the arrow next to Module Serial No. In the list, select the serial 
number of the system you are configuring (see Figure 18). 

Figure 18.  Example Properties Dialog Box: General Tab Page)
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12.2 Configuring the Device Properties

NOTE For details about the settings on any of the
Properties tab pages, click the Help button. 

1. Click the Options tab and verify that the options installed in your IC 
system are enabled. 

To configure an auxiliary power supply (optional):

To operate an electrolytic device such as a water polisher, you can 
configure the Dionex EGC-2 power supply as an auxiliary power 
supply. The power supply operates in constant current mode and can 
be configured from 0 to 200 mA, with a maximum voltage of 35 V. 

• On the Options tab page, select the AuxPower Supply check box 
(see Figure 19) and enter the Maximum Current allowed for the 

Figure 19.  Example Properties Dialog Box: Options Tab Page
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electrolytic device (refer to the documentation provided with the 
device). 

• Connect the device to the EGC-2 connector on top of the Dionex 
ICS-2100.

After the auxiliary power supply is configured, information about the 
power supply (current, on, off, etc.) is displayed in Chromeleon and 
on the front panel touch screens.

2. Click the Inject Valve tab and verify that the correct device is 
assigned to control the injection valve in the Dionex ICS-2100.

• If the timebase will include a AS or Dionex AS-DV, the 
Controlled By setting for Pump_InjectValve must be AS (see 
Figure 20).

Figure 20.  Inject Valve Properties: Inject Valve Controlled by the AS  



Setting Up Chromeleon

Doc. 065294-03 10/12 23

• If the timebase will include another model of autosampler (or no 
autosampler), the Controlled By setting must be ICS-1100 (see 
Figure 21). 

To change a Controlled By setting, select the Pump_InjectValve 
name, press F2, and select the device.

3. After selecting the device properties, click OK to close the dialog 
box. The IC system is added to the timebase (see Figure 22). 

4. If you are configuring an autosampler, add the autosampler to the 
timebase as described for the IC system. 

5. When the timebase is complete, select File > Save Installation.

Figure 21.  Inject Valve Properties: Inject Valve Controlled 
by the IC System 

Figure 22.  Example Server Configuration 
with IC System Added to the Timebase
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6. You can ignore the “no inject device installed” warning, if it appears. 
This simply means that the timebase does not include an autosampler. 
This message appears if you are using manual injections. Close the 
Server Configuration Check dialog box. 

7. Exit the Server Configuration program. 

12.3 Connecting to the Panel Tabset

1. Click Start on the Windows taskbar and select All Programs > 
Chromeleon > Chromeleon to start the Chromeleon client.

The Chromeleon main window and Browser appear (see Figure 23).

Figure 23.  Chromeleon Main Window and Browser

2. Select View > Default Panel Tabset to display the panel tabset.
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3. Click the ICS-2100 tab on the panel tabset to view the IC system 
panel (see Figure 24).

NOTE If an autosampler is installed, a separate Control
panel for the autosampler is included in the panel
tabset.

12.4 Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the IC system by clicking 
the Inject and then the Load button on the panel. If communication is 
occurring, you will hear the valve actuate as it changes position. 

Figure 24.  IC System Panel on the Chromeleon Panel Tabset
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13. Installing and Plumbing the Columns and Suppressor

This section provides brief installation and plumbing instructions for the columns 
and suppressor. For detailed start-up and installation instructions, refer to the 
column and suppressor manuals. The manuals are provided on the Thermo 
Scientific Reference Library DVD (P/N 053891).

For reference, Figure 25 shows the system flow schematic after all plumbing is 
completed. 

Figure 25.  IC System Plumbing Schematic
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13.1 Unpacking the Columns and Suppressor

1. Remove the guard column, separator column, and suppressor from 
their boxes. 

2. Remove the fitting plugs from the ends of each column and from all 
ports on the suppressor. 

3. Discard any tubing temporarily connecting the suppressor ports.

13.2 Setting Up the Column Heater 

Note for 2-mm columns:

For best results with 2-mm columns, install a microbore heat exchanger 
(P/N 060943) in the column heater. In addition, use red 0.125-mm 

(0.005-in) ID PEEK™ tubing (P/N 044221), rather than the standard black 
PEEK tubing, for tubing connections between the following components:

• Injection valve and column heater heat exchanger

• Guard column and separator column

• Separator column and detector cell
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To set up the column heater

1. Cut off the two shipping ties from the column heater and remove 
them (see Figure 26).

2. Loosen the two thumbscrews on the heater cover (they remain 
attached to the cover).

3. Pull the heater cover straight out to remove it.

Figure 26.  Column Heater with Shipping Ties

Thumbscrew (2)

Shipping Tie (2)
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4. Unscrew the six 
thumbscrews on the top 
metal plate (see 
Figure 27) and remove 
the plate.

Figure 27.  Column Heater with Cover Removed

13.3 Plumbing the Columns

1. Remove the coupler connecting the lines labeled GUARD IN and 
GUARD OUT.

2. Connect the GUARD IN line to the guard column inlet. Check the 
arrow on the guard column label; it should point down (flow away 
from the injection valve).

3. Connect the GUARD OUT line to the guard column outlet.

4. Push the guard column onto the back column clip.

5. Remove the coupler connecting the COL IN and COL OUT lines.

6. Connect COL IN to the separator column inlet. Connect COL OUT to 
the separator column outlet. Check the arrow on the column label. It 
should point up (flow toward the cell).

7. Push the separator column onto the front column clips.

8. Replace the top metal plate on the column heater.

Thumbscrew (6) 
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13.4 Installing the Suppressor

1. Before installing the suppressor, hydrate it as instructed in the 
suppressor manual. Suppressor manuals are provided on the Thermo 
Scientific Reference Library DVD (P/N 053891).

2. Locate the suppressor 
mounting tabs on the 
component panel (see 
Figure 28). Reach into 
the opening between the 
tabs and pull the yellow 
connector and attached 
cable slightly out of the 
opening.

Connect this cable to the 
cable from the 
suppressor (align the 
pins on the two 
connectors and push 
them together).

Figure 28.  Suppressor Mounting Tabs 
and Guidelines

3. Orient the suppressor with the REGEN OUT fitting on top and the 
cable to the right. 

4. Feed the cable into the opening in the component panel.

5. Align the top of the suppressor with the guideline printed on the 
component panel (see Figure 28) and align the slots on the rear of the 
suppressor with the tabs on the panel.
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6. Press the suppressor onto the tabs and 
then slide it down to lock it in place. Pull 
slightly on the center of the suppressor to 
verify that it is securely fastened. 
Figure 29 shows a Thermo Scientific 
Dionex SRS Suppressor installed on the 
component panel.

7. Remove the coupler connecting the 

ELUENT IN and ELUENT OUT lines and 
connect these lines to the corresponding 
ports on the suppressor.

Figure 29.  Suppressor Installed 
(Dionex SRS Shown)

8. Remove the fitting plug from the REGEN IN line and connect it to the 
REGEN IN port on the suppressor. 

9. Do not connect the REGEN OUT port until after completing the 
eluent generator setup (Section 18).

10. Replace the cover on the column heater, making sure the GUARD IN 
line is aligned with the slot on the side of the heater cover. 

14. Connecting the Waste Lines

1. Untape the coiled waste lines from the rear panel. Place the ends of the PUMP 

WASTE and TO WASTE OUT lines into a waste container. 

2. Direct the WASTE, GAS SEPARATOR line from the top of the IC system to the 
rear panel. Snap the line onto one of the tubing clips on the rear panel. 
Connect the line to the waste, gas separator tube (see Section 14.1).

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.
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14.1 Installing the Waste, Gas Separator Tube

1. Locate the waste, gas 
separator tube 
assembly in the IC 
system Ship Kit.

2. Connect the WASTE, 

GAS SEPARATOR line 
from the suppressor to 
one of the 3-mm (1/8-
in) ID white PTFE 
lines on the waste, gas 
separator tube 
assembly (see 
Figure 30).

Figure 30.  Waste, Gas Separator Tube Installation

3. Place the waste, gas separator tube assembly into the waste container. 
Make sure the tubing junction (where the white PTFE tubing meets 
the black polyethylene tubing) is above the top of the container and 
that the waste, gas separator tube and the waste container are open to 
the atmosphere.

DO NOT CAP THE WASTE CONTAINER: In the Dionex ICS-2100, the
Thermo Scientific Dionex Atlas® Electrolytic Suppressor and Thermo
Scientific Dionex Self-Regenerating Suppressor (Dionex SRS) use an
electrolytic process that results in the production of small amounts of
oxygen or hydrogen gas. To ensure that the gas is not trapped in a
closed container and allowed to concentrate, install a 1.3-cm (0.52-in)
ID black waste, gas separator tube (P/N 045460) in an uncapped waste
container. Connect the Waste, Gas Separator line to the waste tube
(see Figure 30).

Waste, 

Tube

Gas 
Separator 

Assembly

Waste

Waste, Gas
Separator Line

(from the suppressor)

Connect this
line to a second 
system, 
if needed.

Open to 
the air
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15. Setting Up the Eluent Reservoir

1. Rinse the eluent reservoir with ASTM filtered, Type I (18-megohm) 
deionized water.

2. Fill the reservoir with ASTM filtered, Type I (18-megohm) deionized water.

3. Place the reservoir on top of the IC system.

4. Install the cap and handtighten.

5. Connect the liquid lines from the IC system to the corresponding lines exiting 
the eluent bottle.

NOTE The IC system does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Thermo Scientific recommends
pressurizing the reservoir with helium or nitrogen. See
Section 22 for instructions.

NE FERMEZ PAS LE CONTENEUR DE GAZ RÉSIDUEL: Le Dionex ICS-
2100, le Thermo Scientific Dionex Atlas Electrolytic Suppressor, et le
Thermo Scientific Dionex Self-Regenerating Suppressor (Dionex SRS)
travaillent avec un proces d´électrolyse, qui produit des petites
quantités de gaz d´oxygène ou d´hydrogène. Afin de garantir que le
gaz ne soit pas enfermé dans un conteneur fermé et puisse s´y
concentrer, connectez un tube noir à gaz résiduel (diamètre intérieur =
1,3 cm; n° de commande 045460) à un conteneur ouvert (non fermé).
Connectez le conteneur résiduel au tube résiduel/gaz séparateur
(désigné: « Waste, Gas Separator»). 

VERSCHLIESSEN SIE DEN ABFALLBEHÄLTER NICHT: Der Dionex
ICS-2100, Thermo Scientific Dionex Atlas Electrolytic Suppressor und
Thermo Scientific Dionex Self-Regenerating Suppressor (Dionex SRS)
verwenden einen Elektrolyseprozess, wodurch kleine Mengen an
Sauerstoff und Wasserstoff entstehen. Führen Sie einen schwarzen
Gasabscheiderschlauch (ID = 1,3 cm; Bestell-Nr. 045460) in einen
offenen (unverschlossenen) Abfallbehälter, damit sich das Gas nicht
in einem geschlossenen Behälter sammelt und aufkonzentriert.
Verbinden Sie die mit Waste, Gas Separator bezeichnete Leitung mit
dem Abfallschlauch.
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16. Entering the Eluent Level

After filling the reservoir, enter the volume of liquid in the reservoir.

1. On the IC system panel on the Chromeleon panel tabset, click the Pump 
Settings button. 

The Pump Settings window appears (see Figure 31). 

2. Use the slider to enter the volume (in liters), or enter the volume directly into 
the Eluent Bottle box.

The IC system determines the eluent usage by monitoring the flow rate and the 
length of time the pump is on, and updates the Eluent Bottle volume as the eluent 
is used up. A warning appears if the level falls below 200 mL. Warnings are 
repeated at 100 mL and 0 mL. 

If preferred, you can enter the eluent bottle level on the touch screen HOME page, 
instead of on the Chromeleon Control panel. 

Figure 31.  Pump Settings Window: Setting the Eluent Level 

In order for the level displayed in the Eluent Bottle box and gauge to
be accurate, you must enter the level when the reservoir is filled. The
IC system does not automatically detect when the reservoir is filled,
nor when it is empty.

Enter the
volume of

liquid in the
reservoir
(in liters)

Note: The Eluent 
Bottle field and 
slider gauge are 
updated as the 
liquid is used up.
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17. Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and 
handtightened, and the liquid line from the IC system to the reservoir cap is 
connected (see Section 15).

2. Verify that the waste lines are directed to a waste container.

3. The priming procedure consists of two parts:

• Priming the eluent lines with a syringe (see Section 17.1). Perform this 
procedure at initial installation, after changing eluents, or when eluent 
lines are empty.

• Priming the pump heads with the Prime button (see Section 17.2). 
Perform this procedure after the eluent lines are primed.

17.1 Priming the Eluent Lines with a Syringe 

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.

1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 079803) to the priming valve port on 
the primary pump head (see Figure 32). 

Figure 32.  Pump Head Valve Settings for Priming the Eluent Lines

10 mL Syringe
(P/N 079803)

Priming Valve 
(open)

Port

Waste Valve
(close)

Primary
Pump Head

Secondary
Pump Head
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3. Open the priming valve by turning it one-quarter to one-half turn 
counterclockwise.

4. On the IC system panel on the Chromeleon panel tabset, click the 
Pump Settings button. 

The Pump Settings window appears (see Figure 33).

5. Under Eluent Flow Valve, click Open.

6. Draw the syringe back to begin pulling eluent through the flow path. 
It may take several syringe draws to remove all air or previous eluent 
from the tubing. Draw out a minimum of 20 mL of eluent to ensure 
that the vacuum degas assembly (if installed) is primed.

7. After priming the lines thoroughly, close the priming valve. Do not 
overtighten the priming valve. 

8. Under Eluent Flow Valve, click Closed.

Figure 33.  Pump Settings Window
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17.2 Priming the Pump Heads with the Prime Button

NOTE Perform this procedure after priming the eluent
lines (see Section 17.1).

1. Close the priming valve on the primary pump head (see Figure 34).

2. Open the waste valve on the secondary pump head by turning the 
knob one-quarter to one-half turn counterclockwise (see Figure 34). 
Opening the valve directs the eluent flow path to waste and eliminates 
backpressure.

3. On the Pump Settings window, click the Prime button. Confirm that 
the waste valve is open by clicking OK when the reminder message 
appears. The pump will begin pumping at approximately 3 mL/min.

4. Continue priming the IC system until no air bubbles are exiting the 
pump waste line.

5. On the Pump Settings window, click Pump Off.

6. Close the waste valve. Do not overtighten. The pump is now ready 
for operation.

NOTE If the two standard priming procedures described
above are unsuccessful, prime the pump with
isopropyl alcohol. See Chapter 5 in the IC system
operator’s manual for instructions.

Figure 34.  Pump Head Valve Settings for Priming the Pump Heads

Priming Valve

Waste Valve

Primary
Pump Head

Secondary
Pump Head

(open)

(close)
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18. Setting Up the Eluent Generator

Before Beginning

Remove the Dionex EluGen cartridge (Dionex EGC) and the other items to be 
installed from their shipping containers. Depending on the type of eluent to be 
generated, the other items may include a Dionex Continuously Regenerated Trap 
Column (Dionex CR-TC), a Dionex EPM Electrolytic pH Modifier, and/or a 
Dionex EGC CO3 Mixer. 

NOTE The Dionex EGC degas assembly is installed inside the
Dionex EGC holder at the factory.

Refer to the Dionex EluGen cartridge, Dionex CR-TC, and Dionex EPM manuals 
for the optimal operating conditions for your application. The manuals are 
provided on the Dionex Reference Library CD-ROM (P/N 053891).

18.1 Eluent Generator Setup for KOH, LiOH, MSA, and NaOH 
Eluents

Follow the instructions in this section if you are installing a Dionex KOH, 
LiOH, MSA, or NaOH EluGen cartridge and a Dionex CR-TC.

• If you are installing a K2CO3 cartridge, a Dionex EPM, and a Dionex 
EGC CO3 Mixer (for generating carbonate/bicarbonate eluent), go to 
Section 18.2.

• If you are installing a K2CO3 cartridge and a Dionex EGC CO3 Mixer 
(for generating carbonate eluent), go to Section 18.3.

The Dionex EluGen cartridge contains one of the following: a
corrosive base (KOH, LiOH, or NaOH), a corrosive acid (MSA), or a
concentrated K2CO3 solution. Wear protective eyewear and gloves

when handling the cartridge.

La cartouche d'Dionex EluGen contient un de ce qui suit: une base
corrosive (KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une
solution concentrée de K2CO3. Porter des lunettes et des gants

protectives en manipulant la cartouche.

Die Dionex EluGen-Kartusche enthält eine korrosive Base (KOH, LiOH
oder NaOH), oder eine korrosive Säure (MSA). Tragen Sie daher beim
Umgang mit der Kartusche eine Schutzbrille und Handschuhe.
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Overview

The eluent generator setup procedure for KOH, LiOH, MSA, or NaOH 
eluents consists of the following main steps:

• Installing the Dionex CR-TC.

• Installing the Dionex EluGen cartridge.

• Connecting the Dionex EluGen cartridge vent line.

• Recording the Dionex EluGen cartridge serial number in 
Chromeleon.

• Conditioning the Dionex EluGen cartridge.

• Hydrating the Dionex CR-TC.

• Completing the eluent generator setup.

Items Required to Complete the Setup Procedure

In addition to the Dionex EluGen cartridge and the Dionex CR-TC, you 
will need the following items to complete the eluent generator setup.

Item P/N Use To

Yellow 0.5 mL/min, 7 MPa 
(1000 psi) backpressure coil 
(supplied in the Dionex ICS-
2100 Ship Kit (P/N 064375))

053765 Provide backpressure during 
setup procedures.

Dionex EluGen Cartridge 
Vent Line Tubing Kit 
(supplied with the cartridge)

063092 Vent the cartridge during 
operation.

10-32 to 1/4-28 coupler 
(supplied in the Dionex ICS-
2100 Ship Kit)

042806 Provide a temporary connection 
during setup procedures.

Temporary waste container 
(beaker, bottle, etc.) 
(not supplied)

n/a Collect waste during setup 
procedures.

10-32 fittings
10-32 ferrules

043275
043276

Complete the connections.

1/8-in fittings
1/8-in ferrules

052267
048949

Complete the connections.
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Figure 35 illustrates the Dionex ICS-2100 after the Dionex EluGen 
cartridge is installed.

Figure 35.  Dionex ICS-2100 with a Dionex EluGenCartridge Installed (Top View)

IN EGC OUT

Dionex EluGen
Cartridge

(Dionex EGC)

Dionex EGC
Holder

Dionex EGC and
Dionex CR-TC

Cable Connections
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Figure 36 illustrates the liquid flow path through the eluent generator 
components after all setup steps are complete and the eluent generator is 
ready for operation.

Figure 36.  Eluent Generator Flow Schematic with Dionex CR-TC: 
Use for Generating KOH, LiOH, MSA, or NaOH Eluent 
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Installing the Dionex CR-TC

1. Tilt the cartridge 
holder to view the 
bottom of the holder 
and brace the holder 
against the back corner 
of the Dionex ICS-
2100 (see Figure 37).

Figure 37.  Cartridge Holder (Tilted to View the Bottom)

2. Before installing the 
Dionex CR-TC, note 
the metal ball stud 
inside the bottom of 
the cartridge holder 
(see Figure 37) and the 
bracket on the Dionex 
CR-TC mounting 
plate (see Figure 38). 
These are used to 
mount the Dionex CR-
TC inside the holder 
after it is plumbed. 

Figure 38.  Dionex CR-TC

3. Remove the plugs from the four ports, labeled “P” in Figure 38. Do 
not remove the two electrical connections, labeled “E” in the 
figure.

Metal ball stud 
for mounting the 
Dionex CR-TC

 Bracket for mounting the

P=Port (4)
(Remove plugs)

E= Electrical connection (2)
(Do not remove) 

P

P

P
P

E

E

Dionex CR-TC on the holder
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4. With the Dionex CR-TC oriented as shown in Figure 39, connect 
each line to the corresponding port on the Dionex CR-TC.

NOTE To help retain the fittings and ferrules on the lines,
remove the coupler from each line just before
connecting the line to a port. 

 

Figure 39.  Plumbed Dionex CR-TC

5. Check that none of the lines are caught under the Dionex CR-TC and 
then push the CR-TC onto the metal stud inside the Dionex EGC 
holder (see Figure 40). Push down until the Dionex CR-TC snaps into 
place. 

Figure 40.  Dionex CR-TC Installed in Holder

Regen Out

Regen In

Eluent 
Eluent In Out 
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6. Feed the Dionex CR-TC cable through the slot on the side of the 
Dionex EGC holder (see Figure 41).

7. Turn the Dionex EGC holder right-side up and set it back into 
position.

Installing the Dionex EluGen Cartridge

1. Orient the Dionex 
EluGen cartridge with 
the fittings facing up and 
remove the plugs from 
the Dionex EluGen 
cartridge INLET and 
OUTLET ports (see 
Figure 42).

Figure 42.  Dionex EluGen Cartridge Inlet and Outlet Ports

Figure 41.  Installing the Dionex CR-TC 

Dionex 
CR-TC 
Cable

OUTLET

INLET
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2. Set the Dionex EluGen cartridge in the service area on top of the 
Dionex ICS-2100 and orient it with the cable toward the Dionex EGC 
holder (see Figure 43).

3. Pull the coiled black EGC IN and EGC OUT lines out slightly from the 
cartridge holder. 

4. Disconnect the EGC 

IN line from the 
union that connects 
it to the EGC OUT 
line.

5. Connect EGC IN to 
the EGC INLET port 
(see Figure 44).

Figure 44.  Dionex EGC Inlet Port Connections

Figure 43.  Dionex EluGen Cartridge in Service Area

EGC Cable

EGC IN
INLET
Port
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6. Locate the yellow 
0.5 mL/min, 7 MPa 
(1000 psi) 
backpressure coil 
(P/N 053765) in the 
Dionex ICS-2100 
Ship Kit (P/N 
064375). 

7. Connect one end of 
this coil to the 
Dionex EGC 

OUTLET port (see 
Figure 45). Leave 
the other end of the 
coil unconnected. 

Figure 45.  Dionex EGC Outlet Connection for 
Conditioning the Dionex EGC

NOTE The backpressure coil connection is temporary; it is
required only during the Dionex EluGen cartridge
conditioning procedure described in “Conditioning
the Dionex EluGen Cartridge” on page 50.

8. Turn the Dionex EluGen cartridge over (with the fittings facing 
down). Shake the Dionex EluGen cartridge vigorously, and tap it 
with the palm of your hand 10 to 15 times. Check that all bubbles 
trapped in the eluent generation chamber are dislodged. 

The Dionex EluGen cartridge contains one of the following: a
corrosive base (KOH, LiOH, or NaOH), a corrosive acid (MSA), or a
concentrated K2CO3 solution. Wear protective eyewear and gloves

when handling the cartridge.

La cartouche du Dionex EluGen contient un de ce qui suit: une base
corrosive (KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une
solution concentrée de K2CO3. Porter des lunettes et des gants

protectives en manipulant la cartouche.

Backpressure 

OUTLET
Port

Coil
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9. Slide the Dionex EluGen 
cartridge down into the holder 
until it stops. Make sure the 
cable and backpressure coil 
remain out of the holder (see 
Figure 46). 

NOTE To avoid crimping the
lines inside the holder, do
not twist the cartridge
when you slide it into the
holder. The lines are
designed to coil inside the
holder. 

Figure 46.  Installing the Dionex EluGen Cartridge in the 
Holder

Die Dionex EluGen-Kassette enthält eine korrodierende Base (KOH,
LiOH oder NaOH), eine korrodierende Säure (MSA) oder eine
konzentrierte K2CO3-Lösung. Tragen Sie daher beim Umgang mit

Kassette eine Schutzbrille und Handschuhe.
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10. Remove the plug from 
the EGC-1 connector on 
top of the Dionex ICS-
2100.

11. Orient the cartridge’s 
blue 4-pin electrical 
cable connector as 
shown in Figure 47. 
Push it onto the EGC-1 
connector on the 
Dionex ICS-2100. 
Twist the ring on the 
cable connector 
fingertight to secure it.

Figure 47.  Connecting the Dionex EluGen Cartridge 
Cable

Connecting the Vent Line

1. Locate the vent line tubing kit (P/N 063092) supplied with the Dionex 
EluGen cartridge. Slide the label onto one end of the tubing and then 
push the barbed luer lock onto the tubing.

2. Unscrew and remove 
the plug from the vent 
opening on the side of 
the Dionex EluGen 
cartridge (see 
Figure 48). 

Figure 48.  Dionex EluGen Cartridge Vent Plug

Vent Plug
(remove)
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3. Screw the luer adapter 
onto the vent opening. 
Remove the cap on 
the luer adapter by 
twisting. Save the 
cap. 

4. Twist the luer lock 
and Dionex EluGen 
cartridge vent line 
into the luer adapter 
(see Figure 49).

Figure 49.  Installing the Dionex EluGen Cartridge 
Vent Line

NOTE To prevent leaks from the Dionex EluGen cartridge, 
always replace the luer adapter cap before moving 
the cartridge.

5. Direct the Dionex EluGen cartridge vent line to the rear of the Dionex 
ICS-2100 and snap it onto one of the tubing clips on the rear panel. 

6. Direct the vent line to the waste container and insert it down into the 
waste, gas separator tube about 10 to 15 cm (4 to 6 in).

Recording the Dionex EluGen Cartridge Serial Number in 
Chromeleon 

The serial number is printed on the Dionex EluGen cartridge label.

1. Open the Chromeleon Server Configuration program (select Start > 
Programs > Chromeleon > Server Configuration).

2. Double-click the Dionex ICS-2100 system icon. The properties 
dialog box for the Dionex ICS-2100 appears. 

3. Click the Eluent Generator tab (see Figure 50).

4. Select the EGC-1 check box and enter the Dionex EluGen cartridge 
serial number.

Luer Adapter

EGC Vent Line

Luer Lock
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5. Click OK.

Conditioning the Dionex EluGen Cartridge

After completing the installation steps described in the previous sections, 
condition the Dionex EluGen cartridge for 30 minutes. 

1. Set a temporary waste container, such as a beaker, on top of the 
Dionex ICS-2100 and direct the yellow backpressure coil from the 
Dionex EluGen cartridge OUTLET port to the container.

2. On the Dionex ICS-2100 touch screen HOME page, set the pump flow 
rate to 1.00 mL/min. 

3. Touch the EGC button on the HOME page to open the ELUENT 

GENERATOR page. Set the Dionex EGC concentration to 50 mM.

4. Verify that the suppressor and Dionex CR-TC are off.

Figure 50.  Eluent Generator Configuration Properties: OH Example
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5. Verify that the Automatically turn on with pump options are not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page 
and ELUENT GENERATOR page. Disabling these options lets you turn 
on the pump, without automatically turning on the suppressor and 
Dionex CR-TC.

6. Verify that the eluent reservoir is filled with ASTM filtered, Type 1 
(18 megohm-cm) deionized water (see Section 15).

7. Turn on the pump.

8. Turn on the Dionex EluGen cartridge.

9. Run at the selected settings (1.00 mL/min at 50 mM) for 30 minutes.

10. Turn off the Dionex EluGen cartridge.

11. Turn off the pump.

12. Disconnect the Dionex EluGen cartridge cable.

13. Remove the backpressure tubing from the waste container and 
remove the waste container.

14. Lift the Dionex EluGen cartridge out of the holder, turn it over, and 
set it in the service area. 

To avoid damaging the suppressor and Dionex CR-TC, always turn off
the suppressor and Dionex CR-TC before conditioning the Dionex
EluGen cartridge. The pump flow is on during conditioning, however,
no flow reaches the suppressor or Dionex CR-TC.
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15. Disconnect the 
backpressure coil 
from the Dionex 
EluGen cartridge 
OUTLET port.

16. Connect the EGC 

OUT line to the 
OUTLET port (see 
Figure 51).

Figure 51.  Dionex EGC Inlet and Outlet Connections

17. Turn over the Dionex EluGen cartridge. Check for bubbles; if 
necessary, shake and tap the Dionex EluGen cartridge to remove 
bubbles.

18. Reinstall the Dionex EluGen cartridge in the holder.

19. Do not reconnect the Dionex EluGen cartridge cable until after 
hydrating the Dionex CR-TC.

Hydrating the Dionex CR-TC

Always hydrate the Dionex CR-TC before initial operation. This requires 
running ASTM filtered, Type 1 (18 megohm-cm) deionized water through 
the Dionex CR-TC for 10 minutes, while bypassing the columns and 
suppressor.
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Figure 52 illustrates the liquid flow path through the Dionex CR-TC 
during the hydration procedure.

1. Disconnect the TO INJ VALVE IN - P/ELUENT OUT line from port P (2) 
on the injection valve.

2. Disconnect the TO SRS/AES REGEN OUT line from the suppressor.

3. Use a 10-32 to 1/4-28 coupler (P/N 042806) to connect the TO INJ 

VALVE IN - P/ELUENT OUT line to the SRS/AES REGEN OUT line.

4. Verify that the suppressor is off.

5. Verify that the Automatically turn on with pump option is not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page. 

Figure 52.  Dionex CR-TC Plumbing for Hydration

To avoid damaging the suppressor, always turn off the suppressor
before hydrating the Dionex CR-TC. The pump flow is on during
conditioning, however, no flow reaches the suppressor.
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Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

6. Turn on the pump and set the flow to the rate recommended for your 
application. 

7. Pump deionized water through the Dionex CR-TC for at least 
10 minutes.

8. Turn off the pump and remove the coupler.

Completing the Eluent Generator Setup

1. Reconnect the TO SRS/AES REGEN OUT line to the REGEN OUT port 
on the suppressor.

2. Reconnect the TO INJ VALVE IN - P/ELUENT OUT line to port P (2) on 
the injection valve.

3. Reconnect the Dionex EluGen cartridge cable.

4. Remove the plug from the Dionex CR-TC connector on top of the 
Dionex ICS-2100

5. Orient the Dionex 
CR-TC’s black 3-pin 
electrical cable 
connector as shown in 
Figure 47. Push it 
onto the Dionex CR-TC 
connector on the 
Dionex ICS-2100. 
Twist the ring on the 
cable connector and 
fingertighten to 
secure it.

Figure 53.  Connecting the Dionex CR-TC Cable

NOTE Backpressure tubing may be required between the
injection valve and the Dionex EGC degas eluent
outlet. The Dionex EluGen cartridge requires 14 to
16 MPa (2000 to 2300 psi) of system backpressure
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for removal of electrolysis gas from the eluent
produced by the cartridge. See Section 19.1 for
details.

6. Go on to Section 19, “Equilibrating the System.”

18.2 Eluent Generator Setup for Carbonate/Bicarbonate 
Eluent

Follow the instructions in this section if you are installing a Dionex  
K2CO3 cartridge, a Dionex EPM, and a Dionex EGC CO3 Mixer (for 
generating carbonate/bicarbonate eluent).

• If you are installing a Dionex K2CO3 cartridge and a Dionex EGC 
CO3 Mixer (for generating carbonate eluent), go to Section 18.3.

• If you are installing a Dionex KOH, LiOH, MSA, or NaOH EluGen 
cartridge and a Dionex CR-TC, go to Section 18.1.

Overview

The eluent generator setup procedure for carbonate/bicarbonate eluent 
consists of the following main steps:

• Installing the Dionex EluGen cartridge.

• Connecting the Dionex EluGen cartridge vent line.

• Installing the Dionex EPM.

• Plumbing the Dionex EPM for conditioning.

• Recording the Dionex EluGen cartridge and the Dionex EPM serial 
numbers in Chromeleon.

• Conditioning the Dionex EluGen cartridge and the Dionex EPM.

• Installing the Dionex EGC CO3 Mixer.

• Temporarily filling the Dionex EGC CO3 Mixer with deionized 
water.

• Filling the Dionex EGC CO3 Mixer with eluent of the required 
concentration.

• Completing the eluent generator setup.
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Items Required to Complete the Setup Procedure

The following items are required to set up the Dionex EluGen cartridge, 
Dionex EPM, and Dionex EGC CO3 Mixer. Except as noted, all items are 
supplied in the Dionex ICS-2100 Ship Kit (P/N 064375).

Item P/N Used To

Dionex EPM mounting bracket 063624 Mount the Dionex EPM on the Dionex EGC 
holder.

35 cm (14 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing 

064340 Lengthen the line between the Dionex EGC 
degas eluent inlet and the Dionex EPM 
ELUENT OUT port.

30 cm (12 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing

064334 Lengthen the line between the Dionex 
EluGen cartridge outlet and the Dionex EPM 
ELUENT IN port.

28 cm (11 in) of clear 1.58-mm 
(0.062-in) ID PTFE tubing

064337 Lengthen the line between the Dionex EGC 
degas regenerant inlet and the Dionex EPM 
REGEN OUT port.

Dionex EluGen Cartridge Vent 
Line Tubing Kit (supplied with the 
cartridge)

063092 Vent the cartridge during operation.

Yellow 0.5 mL/min, 7 MPa 
(1000 psi) backpressure coil

053765 Provide backpressure during setup 
procedures.

Dionex EGC CO3 Mixer 

mounting clips

063642 Install the mixer.

Phillips head screwdriver 
(not supplied)

n/a Install the Dionex EGC CO3 Mixer mounting 

clips.

35 cm (14 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing

064346 Connect the Dionex EGC degas eluent outlet 
and the Dionex EGC CO3 Mixer inlet.

60 cm (24 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing

064343 Connect the Dionex EGC CO3 Mixer outlet 
to port P (2) on the injection valve.

Temporary waste container 
(beaker, bottle, etc.) (not supplied)

n/a Collect waste during setup procedures.

10-32 to 10-32 coupler
10-32 to 1/4-28 coupler

042627
042806

Complete the connections.
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Figure 54 illustrates the Dionex EluGen cartridge and Dionex EPM after 
installation.

10-32 fittings
10-32 ferrules

043275
043276

Complete the connections.

1/8-in fittings
1/8-in ferrules

052267
048949

Complete the connections.

Figure 54.  Dionex ICS-2100 with a Dionex EluGenCartridge and Dionex EPM 
Installed

Item P/N Used To

Dionex
EluGen

Cartridge

EGC Holder

Dion
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Figure 55 illustrates the liquid flow path through the eluent generator 
components after all setup steps are complete and the eluent generator is 
ready for operation.

Figure 55.  Eluent Generator Flow Schematic with a Dionex EPM and Dionex EGC 
CO3 Mixer: Use for Generating Carbonate/Bicarbonate Eluent
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Installing the Dionex EluGen Cartridge

1. Tilt the cartridge 
holder to view the 
bottom and brace the 
holder against the back 
corner of the Dionex 
ICS-2100 (see 
Figure 56).

Figure 56.  Cartridge Holder (Tilted to View the Bottom)
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2. Use the precut tubing assemblies included in the Dionex ICS-2100 
Ship Kit to extend the length of three lines as described below:

a. Disconnect the TO CR-TC ELUENT IN line (red label) from the 
coupler that connects it to the TO CR-TC ELUENT OUT line (yellow 
label). Connect a 32 to 10-32 coupler to the end of the TO CR-TC 

ELUENT IN line and connect the 30 cm (12 in) length of black 
PEEK tubing (red labels) (P/N 064334) to the coupler (see 
Figure 57).

b. Connect the 35 cm (14 in) length of black PEEK tubing (yellow 
labels) (P/N 064340) to the coupler on the TO CR-TC ELUENT OUT 
line (yellow label).

c. Disconnect the TO CR-TC REGEN IN line (orange label) from the 
coupler that connects it to the TO CR-TC REGEN OUT line (blue 
label). Connect the 28 cm (11 in) length of clear PTFE tubing 
(blue labels) (P/N 064337) to the coupler on the TO CR-TC REGEN 

OUT line (blue label).

Figure 57.  Dionex EPM Eluent and Regen Line Extensions

TO CR-TC/EPM 
ELUENT OUT 
Line (yellow 
label)

TO CR-TC/EPM
ELUENT IN

Line (red label) TO CR-TC/EPM 
REGEN OUT 
Line (blue label)
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3. Pull the TO CR-TC REGEN IN line (orange label) out of the opening on 
the side of the holder.

4. Thread the three extended lines (red, yellow, and blue labels) through 
the opening on the side of the holder (see Figure 58).

5. Turn the Dionex EGC holder right-side up and set it back into 
position.

6. Orient the Dionex 
EluGen cartridge with 
the fittings facing up and 
remove the plugs from 
the cartridge INLET and 
OUTLET fittings (see 
Figure 59).

Figure 59.  Dionex EluGen Cartridge Fitting Plugs

Figure 58.  TO CR-TC/EPM Lines Outside of Holder

TO DCR-TC/EPM 
ELUENT OUT 
(yellow label)

TO CR-TC/EPM
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TO CR-TC/EPM
REGEN OUT
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OUTLET
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7. Set the Dionex EluGen cartridge in the service area on top of the 
Dionex ICS-2100 and orient it with the cable toward the Dionex EGC 
holder (see Figure 60).

8. Pull the coiled black EGC IN and EGC OUT lines out from inside the 
Dionex EGC holder. Disconnect the EGC IN line from the coupler that 
connects it to the EGC OUT line.

9. Connect the EGC IN 

line to the Dionex 
EluGen cartridge 
INLET port (see 
Figure 61).

10. Remove the coupler 
and connect the EGC 

OUT line to the Dionex 
EluGen cartridge 
OUTLET port.

Figure 61.  Dionex EluGen Cartridge Inlet and Outlet Port Connections

Figure 60.  Dionex EluGen Cartridge in Service Area

EGC Cable
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11. Turn the Dionex EluGen cartridge over (with the fittings facing 
down). Shake the Dionex EluGen cartridge vigorously, and tap it 
with the palm of your hand 10 to 15 times. Check that all bubbles 
trapped in the eluent generation chamber are dislodged. 

12. Slide the Dionex EluGen cartridge down 
into the holder until it stops (see 
Figure 62). Make sure the cable remains 
out of the holder. 

NOTE To avoid crimping the lines, do not
twist the cartridge when you slide it
into the holder. The lines are
designed to coil inside the holder. 

Figure 62.  Dionex EluGen Cartridge Installed in the Holder

The Dionex EluGen cartridge contains one of the following: a
corrosive base (KOH, LiOH, or NaOH), a corrosive acid (MSA), or a
concentrated K2CO3 solution. Wear protective eyewear and gloves

when handling the cartridge.

La cartouche du Dionex EluGen contient un de ce qui suit: une base
corrosive (KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une
solution concentrée de K2CO3. Porter des lunettes et des gants

protectives en manipulant la cartouche.

Die Dionex EluGen-Kassette enthält eine korrodierende Base (KOH,
LiOH oder NaOH), eine korrodierende Säure (MSA) oder eine
konzentrierte K2CO3-Lösung. Tragen Sie daher beim Umgang mit

Kassette eine Schutzbrille und Handschuhe.
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13. Remove the plug from 
the EGC-1 connector on 
top of the Dionex ICS-
2100.

14. Orient the cartridge’s 
blue 4-pin electrical 
cable connector as 
shown in Figure 63. 
Push it onto the EGC-1 
connector on the 
Dionex ICS-2100. 
Twist the ring on the 
cable connector 
fingertight to secure it.

Figure 63.  Connecting the Dionex EluGen Cartridge Cable

Connecting the Dionex EluGen Cartridge Vent Line

1. Locate the Dionex EluGen Cartridge Vent Line Tubing Kit supplied 
with the cartridge. 

2. Slide the label onto one end of the tubing and then push the barbed 
luer lock onto the tubing.

3. Unscrew and remove 
the plug from the vent 
opening on the side of 
the Dionex EluGen 
cartridge (see 
Figure 64). 

Figure 64.  Dionex EluGen Cartridge Vent Plug

Vent Plug
(remove)
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4. Screw the luer adapter 
onto the vent opening. 
Remove the cap on 
the luer adapter by 
twisting. Save the 
cap. 

5. Twist the luer lock 
and Dionex EluGen 
cartridge vent line 
into the luer adapter 
(see Figure 65).

Figure 65.  Installing the Dionex EluGen Cartridge Vent Line

NOTE To prevent leaks from the Dionex EluGen
cartridge, always replace the luer adapter cap
before moving the cartridge.

6. Direct the vent line to the waste container and insert it down into the 
waste, gas separator tube about 10 to 15 cm (4 to 6 in).

Installing the Dionex EPM

1. Remove the plugs from 
the Dionex EPM eluent 
and regen liquid ports.

2. Push the Dionex EPM 
onto the ball studs on 
the mounting bracket 
(see Figure 66).

Figure 66.  Dionex EPM and Mounting Bracket

Luer Adapter

EGC Vent Line 

Luer Lock

Ball Studs

Mounting Bracket

Dionex 
EPM
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3. Lift the Dionex EluGen 
cartridge up slightly 
from the Dionex EGC 
holder and slide the 
Dionex EPM bracket 
onto the side of the 
holder (see Figure 67).

Figure 67.  Dionex EPM and Mounting Bracket Installed on Dionex EGC Holder

4. Connect the following lines to the Dionex EPM:

• Connect the TO CR-TC/EPM ELUENT OUT line (yellow label) to 
the ELUENT OUT port on the Dionex EPM (see Figure 68).

• Connect the TO CR-TC/EPM ELUENT IN line (red label) to the 
ELUENT IN port on the Dionex EPM.

• Connect the TO CR-TC/EPM REGEN IN line (orange label) to the 
REGEN IN port on the Dionex EPM.

• Connect the TO CR-TC/EPM REGEN OUT line (blue label) to the 
REGEN OUT port on the Dionex EPM.

EGC Cable
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5. Remove the plug from the EGC-2 connector on top of the Dionex ICS-
2100.

6. Connect the Dionex EPM electrical cable to the EGC-2 connector.

Figure 68.  Dionex EluGen Cartridge and Dionex EPM Plumbing with Tubing 
Extensions
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Recording the Dionex EluGen Cartridge and Dionex EPM Serial 
Numbers in Chromeleon 

The serial numbers are printed on labels on the Dionex EluGen cartridge 
and Dionex EPM.

1. Open the Server Configuration program (select Start > Programs > 
Chromeleon > Server Configuration).

2. Double-click the Dionex ICS-2100 system icon. The properties 
dialog box for the Dionex ICS-2100 appears. 

3. Click the Eluent Generator tab (see Figure 69).

4. Select the EGC-1 check box and enter the Dionex EluGen cartridge 
serial number.

5. Select the EGC-2 check box and enter the serial number of the 
Dionex EPM.
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6. Click OK.

Figure 69.  Eluent Generator Configuration Properties: CO3 / Dionex EPM 
Example
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Plumbing the Dionex EluGen Cartridge and Dionex EPM for 
Conditioning

 Figure 70 illustrates the liquid flow path through the Dionex EluGen 
cartridge and Dionex EPM during the conditioning procedure.

Figure 70.  Dionex EluGen Cartridge and Dionex EPM Plumbing for Conditioning with 
Carbonate/Bicarbonate Eluent
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1. Disconnect the TO INJ VALVE IN - P/ELUENT OUT line from port P (2) 
on the injection valve. 

2. Use a 10-32 to 10-32 coupler (P/N 042627) to connect the yellow 
0.5 mL/min, 7 MPa (1000 psi) backpressure coil (P/N 053765) to the 
TO INJ VALVE IN - P/ELUENT OUT line.

3. Connect a 10-32 to 1/4-28 coupler (P/N 042806) to the free end of the 
backpressure coil.

4. Disconnect the TO SRS/AES REGEN OUT line from the suppressor 
REGEN OUT port.

5. Connect the TO SRS/AES REGEN OUT line to the 10-32 to 1/4-28 
coupler (see Figure 71).

NOTE The backpressure coil connection in Figure 71 is
temporary; it is required only during the Dionex
EPM and Dionex EluGen cartridge conditioning
procedure described in the next section.

Figure 71.  Backpressure Coil Connections for Conditioning the 
Dionex EluGen Cartridge and Dionex EPM with Carbonate/Bicarbonate Eluent
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Conditioning the Dionex EPM and Dionex EluGen Cartridge

After completing the plumbing connections described in the previous 
sections, follow the steps below to hydrate the Dionex EPM for 5 minutes 
and then condition the Dionex EPM and Dionex EluGen cartridge for 30 
minutes. 

1. Make sure the eluent reservoir is filled with ASTM filtered, Type I 
(18-megohm) deionized water.

2. Verify that the suppressor is off.

3. Verify that the Automatically turn on with pump option is not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page. 
Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

4. On the Dionex ICS-2100 touch screen HOME page, set the pump flow 
rate to 1.00 mL/min.

5. Turn on the pump.

6. Run the pump for 5 minutes to hydrate the Dionex EPM.

7. Touch the EGC button on the HOME page to open the ELUENT 

GENERATOR page. 

8. Verify that the cartridge type for EGC-1 is Carb and the type for EGC-2 
is pH Mod. 

If the cartridge types are wrong, make sure the cartridge serial 
numbers were entered correctly in the Chromeleon Server 
Configuration program (see “Recording the Dionex EluGen Cartridge 
and Dionex EPM Serial Numbers in Chromeleon” on page 68).

9. Select the following settings: 

• Set the EGC-1 concentration to 9 mM. 

• Set the EGC-2 concentration to 1 mM.

10. Turn on the EGC-1 and EGC-2 currents. 

To avoid damaging the suppressor, always turn off the suppressor
before conditioning the Dionex EPM and Dionex EluGen cartridge.
The pump flow is on during conditioning, however, no flow reaches
the suppressor.
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11. Run the Dionex EluGen cartridge and Dionex EPM at these settings 
for 30 minutes.

12. Turn off the EGC-1 and EGC-2 current.

13. Turn off the pump.

Installing the Dionex EGC CO3 Mixer

Figure 72 illustrates the Dionex EGC CO3 Mixer after installation.

Figure 72.  Dionex ICS-2100 with a Dionex EGC CO3 Mixer Installed
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1. Use a Phillips head screwdriver to 
remove the existing small diameter 
mounting clips from the inside of 
the Dionex ICS-2100 door.

2. Install the larger diameter clips 
(P/N 063642) (see Figure 73).

Figure 73.  Location of Mounting Clips for the Dionex EGC CO3 Mixer

3. Orient the mixer with the outlet 
pointing upward and push it onto the 
clips (see Figure 74). The mixer 
outlet must point upward to ensure 
thorough mixing of the eluent.

4. Locate the 35 cm (14 in) length of 
black PEEK tubing (white labels) 
(P/N 064346). Connect the end 
labeled TO EGC CO3 MIXER IN to the 
mixer inlet.

5. Locate the 60 cm (24 in) length of 
black PEEK tubing (white labels) 
(P/N 064343). Connect the end 
labeled TO EGC CO3 MIXER OUT to 
the mixer outlet.

Figure 74.  Dionex EGC CO3 Mixer Installed on the Dionex ICS-2100 Door

Mixer
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Filling the Dionex EGC CO3 Mixer with Deionized Water

1. Verify that the EGC-1 and EGC-2 currents are off.

2. Disconnect the Dionex EluGen cartridge inlet line (labeled TO 

PUMP/DAMPER) from the coupler that connects it to the green pump 
outlet line (see Figure 75).

Figure 75.  Dionex EluGen Cartridge Inlet and Pump Outlet
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3. Connect the pump outlet to the mixer inlet (see Figure 76).

4. Direct the mixer outlet line to a temporary waste container, such as a 
beaker.

5. Verify that the suppressor is off.

6. Verify that the Automatically turn on with pump option is not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page. 
Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

7. Set the pump flow rate to 5.00 mL/min.

8. Turn on the pump.

9. Run the pump until the mixer is filled and there is a consistent flow of 
water exiting the mixer outlet. 

It takes about 5 minutes to fill a 4-mm mixer and about 2 minutes to 
fill a 2-mm mixer.

10. Turn off the pump.

Figure 76.  Pump Outlet Connected to Mixer Inlet for Mixer Hydration

To avoid damaging the suppressor, always turn off the suppressor
before filling the mixer. The pump flow is on during filling, however,
no flow reaches the suppressor.

Mixer Inlet

Pump Outlet
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Filling the Dionex EGC CO3 Mixer with the Carbonate/Bicarbonate 
Eluent

Before initial use, follow the steps in this section to fill the Dionex EGC 
CO3 Mixer with the carbonate/bicarbonate eluent concentration required 
for the application to be run. 
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Figure 77 illustrates the liquid flow path through the eluent generator 
components during initial filling of the Dionex EGC CO3 Mixer with 
carbonate/bicarbonate eluent.

1. Disconnect the pump outlet from the mixer inlet.

2. Reconnect the pump outlet and the Dionex EluGen cartridge inlet.

3. Connect a 10-32 to 10-32 coupler to the mixer inlet.

Figure 77.  Dionex EluGen Cartridge and Dionex EPM Plumbing for Initial Filling 
of the Dionex EGC CO3 Mixer with Carbonate/Bicarbonate Eluent
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4. Disconnect the outlet of the yellow PEEK backpressure coil from the 
TO SRS/AES REGEN OUT line and then connect the backpressure coil 
to the mixer inlet (see Figure 78).

5. Connect the mixer outlet to the TO SRS/AES REGEN OUT line.

NOTE The backpressure coil connection is temporary;
it is required only during initial filling of the
mixer.

6. Verify that the suppressor is off.

Figure 78.  Mixer Connected Directly to Eluent 
Generator Outlet for Initial Filling

To avoid damaging the suppressor, always turn off the suppressor
before filling the mixer. The pump flow is on during filling, however,
no flow reaches the suppressor.
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7. Verify that the Automatically turn on with pump option is not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page. 
Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

8. Set the pump flow rate to the rate required for the application.

9. Turn on the pump.

10. Verify that the system backpressure is between 14 and 16 MPa (2000 
and 2300 psi). If necessary, adjust the pressure by adding or removing 
backpressure tubing.

11. Set the EGC-1 and EGC-2 concentrations to the values required for 
your application. For example, for a 3.5 mM K2CO3/1.0 mM KHCO3 
mixture, set the EGC-1 concentration to 3.5 mM and the EGC-2 
concentration to 1.0 mM.

12. Turn on the EGC-1 and EGC-2 currents.

13. Run at the selected settings until the mixer is filled with the eluent 
mixture. At a flow rate of 1 mL/min it will take about 45 minutes to 
fill the 4-mm mixer and about 15 minutes to fill the 2-mm mixer.

NOTE The void volume of the 4-mm mixer is about
16 mL. The void volume of the 2-mm mixer is
about 5 mL. 

14. Turn off the EGC-1 and EGC-2 currents.

15. Turn off the pump.

16. Remove the yellow PEEK backpressure coil from the TO INJ VALVE 

IN - P/ELUENT OUT line and the mixer inlet.

17. Disconnect the mixer outlet from the TO SRS/AES REGEN OUT line 
and remove the 10-32 to 1/4-28 coupler.

18. Reconnect the TO SRS/AES REGEN OUT line to the suppressor REGEN 

OUT port.
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Completing the Eluent Generator Setup for Carbonate/Bicarbonate 
Eluent

Figure 79 illustrates the liquid flow path through the system after all setup 
steps are complete and the eluent generator is ready for operation.

Figure 79.  Dionex ICS-2100 Flow Schematic: Carbonate/Bicarbonate Eluent 
Generation
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1. Connect the TO INJ VALVE IN - P/ELUENT OUT line to the coupler 
attached to the mixer inlet line. Route this line along the back of the 
drip tray to prevent it from being pinched when the Dionex ICS-2100 
door is opened and closed

2. Route the mixer outlet line to the back of the component panel (see 
Figure 80).

3. Connect the mixer outlet line to port P (2) on the injection valve. 

NOTE Backpressure tubing may be required between the
injection valve and the Dionex EGC CO3 Mixer
outlet. The Dionex EluGen cartridge requires 14 to
16 MPa (2000 to 2300 psi) of system backpressure
for removal of electrolysis gas from the eluent
produced by the cartridge. See Section 19.1 for
details.

4. Go on to Section 19, “Equilibrating the System.”

Figure 80.  Mixer Outlet Routed to the Back of the Component Panel 
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18.3 Eluent Generator Setup for Carbonate Eluent

Follow the instructions in this section if you are installing a Dionex 
K2CO3 cartridge and a Dionex EGC CO3 Mixer (for generating carbonate 
eluent).

• If you are installing a Dionex KOH, LiOH, MSA, or NaOH EluGen 
cartridge and a Dionex CR-TC, go to Section 18.1.

• If you are installing a Dionex K2CO3 cartridge, a Dionex EPM, and a 
Dionex EGC CO3 Mixer (for generating carbonate/bicarbonate 
eluent), go to Section 18.2.

Overview

The eluent generator setup procedure for carbonate eluent consists of the 
following main steps:

• Installing the Dionex EluGen cartridge and preparing for 
conditioning.

• Conditioning the Dionex EluGen cartridge.

• Installing the Dionex EGC CO3 Mixer.

• Filling the Dionex EGC CO3 Mixer with the eluent concentration 
required for the application.

• Completing the eluent generator setup.
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Items Required to Complete the Setup Procedure

In addition to the Dionex EluGen cartridge and the Dionex EGC CO3 
Mixer, you will need the following items to complete the eluent generator 
setup. Except as noted, all items are supplied in the Dionex ICS-2100 
Ship Kit (P/N 064375).

Item P/N Use To

Yellow 0.5 mL/min, 7 MPa 
(1000 psi) backpressure coil

053765 Provide backpressure during 
setup procedures.

Dionex EluGen Cartridge 
Vent Line Tubing Kit 
(supplied with the cartridge)

063092 Vent the cartridge during 
operation.

Dionex EGC CO3 Mixer 
mounting clips

063642 Install the mixer.

Phillips head screwdriver (not 
supplied)

n/a Install the Dionex EGC CO3 
Mixer mounting clips.

35 cm (14 in) of black 
0.25-mm (0.010-in) ID PEEK 
tubing

064346 Connect the Dionex EGC degas 
eluent outlet and the Dionex 
EGC CO3 Mixer inlet.

60 cm (24 in) of black 
0.25-mm (0.010-in) ID PEEK 
tubing

064343 Connect the Dionex EGC CO3 
Mixer outlet to port P (2) on the 
injection valve.

Temporary waste container 
(beaker, bottle, etc.) (not 
supplied)

n/a Collect waste during setup 
procedures.

10-32 fittings
10-32 ferrules

043275
043276

Complete the plumbing 
connections.

1/8-in fittings
1/8-in ferrules

052267
048949

Complete the plumbing 
connections.

10-32 to 10-32 couplers 042627 Complete the plumbing 
connections.
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Figure 81 illustrates the liquid flow path through the eluent generator 
components after all setup steps are complete and the eluent generator is 
ready for operation.

Figure 81.  Eluent Generator Flow Schematic with a Dionex EGC CO3 Mixer:
Use for Generating Carbonate Eluent

EGC 
DEGAS

EGC 
IN

Connect to
Gas Separator 

Assembly

TO SRS/AES
REGEN OUT

WASTE, 
GAS

SEPARATOR

Pre-plumbed 
 Pump Pulse 

Damper
to

Inlet Outlet

EGC VENT

Send to waste

EGC 
OUT

EGC II 
K CO2 3

TO DEGAS
ELUENT IN

Back-
pressure

Coil*

Connect 
 Inject Valve
Port P (2)

to

EGC CO  
Mixer

3

Connect to
Suppressor
Regen Out

TO DEGAS
ELUENT OUT

*Add backpressure coils, if needed, to 
create a system backpressure of between 
14 and 16 MPa (2000 and 2300 psi). 

TO PUMP/
DAMPER

TO EGC CO3 
MIXER IN

TO EGC CO3 
MIXER OUT

TO INJ VALVE 
PORT P

TO INJ 
VALVE IN - P 
ELUENT OUT



Dionex ICS-2100 Installation Instructions

86 Doc. 065294-03 10/12

Installing the Dionex EluGen Cartridge and Preparing for 
Conditioning

Follow the steps in this section to install the Dionex EluGen cartridge and 
prepare it for conditioning before initial use.

Figure 82 illustrates the liquid flow path during the conditioning 
procedure.

Figure 82.  Dionex EluGen Cartridge Plumbing for Conditioning with Carbonate Eluent
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1. Orient the Dionex 
EluGen cartridge with 
the fittings facing up and 
remove the plugs from 
the cartridge INLET and 
OUTLET fittings (see 
Figure 84).

Figure 83.  Dionex EluGen Cartridge Fitting Plugs

2. Set the Dionex EluGen cartridge in the service area on top of the 
Dionex ICS-2100 and orient it with the cable toward the Dionex EGC 
holder (see Figure 84).

Figure 84.  Dionex EluGen Cartridge in Service Area

OUTLET

INLET

EGC Cable
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3. Pull the coiled black EGC IN and EGC OUT lines out from inside the 
Dionex EGC holder. Disconnect the EGC IN line from the coupler that 
connects it to the EGC OUT line.

4. Connect the EGC IN 

line to the Dionex 
EluGen cartridge 
INLET port (see 
Figure 85).

5. Remove the coupler 
and connect the EGC 

OUT line to the Dionex 
EluGen cartridge 
OUTLET port.

Figure 85.  Dionex EluGen Cartridge Port Connections

6. Turn the Dionex EluGen cartridge over (with the fittings facing 
down). Shake the Dionex EluGen cartridge vigorously, and tap it 
with the palm of your hand 10 to 15 times. Check that all bubbles 
trapped in the eluent generation chamber are dislodged. 

The Dionex EluGen cartridge contains one of the following: a
corrosive base (KOH, LiOH, or NaOH), a corrosive acid (MSA), or a
concentrated K2CO3 solution. Wear protective eyewear and gloves

when handling the cartridge.

La cartouche du Dionex EluGen contient un de ce qui suit: une base
corrosive (KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une
solution concentrée de K2CO3. Porter des lunettes et des gants

protectives en manipulant la cartouche.

Die Dionex EluGen-Kassette enthält eine korrodierende Base (KOH,
LiOH oder NaOH), eine korrodierende Säure (MSA) oder eine
konzentrierte K2CO3-Lösung. Tragen Sie daher beim Umgang mit

Kassette eine Schutzbrille und Handschuhe.
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7. Slide the Dionex EluGen cartridge down 
into the holder until it stops (see 
Figure 86). Make sure the cable remains 
out of the holder. 

NOTE To avoid crimping the lines, do not
twist the cartridge when you slide
it into the holder. The lines are
designed to coil inside the holder. 

Figure 86.  Dionex EluGen Cartridge Installed in the Holder

8. Remove the plug from 
the EGC-1 connector on 
top of the Dionex ICS-
2100.

9. Orient the cartridge’s 
blue 4-pin electrical 
cable connector as 
shown in Figure 87. 
Push it onto the EGC-1 
connector on the 
Dionex ICS-2100. 
Twist the ring on the 
cable connector 
fingertight to secure it.

Figure 87.  Connecting the Dionex EluGen Cartridge Cable
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10. Disconnect the TO INJ VALVE IN - P/ELUENT OUT line from port P (2) 
on the injection valve. 

11. Use a 10-32 to 10-32 coupler (P/N 042627) to connect the TO INJ 

VALVE IN - P/ELUENT OUT line to one end of the yellow 0.5 mL/min, 
7 MPa (1000 psi) backpressure coil (P/N 053765) (see Figure 88).

12. Direct the free end of the backpressure coil to a temporary waste 
container.

Installing the Dionex EluGen Cartridge Vent Line

1. Locate the Dionex EluGen Cartridge Vent Line Tubing Kit 
(P/N 063092) supplied with the Dionex EluGen cartridge. 

2. Slide the label onto one end of the tubing and then push the barbed 
luer lock onto the tubing.

Figure 88.  Plumbing Connections for Conditioning the 
Dionex EluGen Cartridge with Carbonate Eluent
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3. Unscrew and remove 
the plug from the vent 
opening on the side of 
the Dionex EluGen 
cartridge (see 
Figure 90). 

Figure 89.  Dionex EluGen Cartridge Vent Plug

4. Screw the luer adapter 
onto the vent opening. 
Remove the cap on 
the luer adapter by 
twisting. Save the 
cap. 

5. Twist the luer lock 
and Dionex EluGen 
cartridge vent line 
into the luer adapter 
(see Figure 90).

Figure 90.  Installing the Dionex EluGen Cartridge Vent Line

NOTE To prevent leaks from the Dionex EluGen cartridge, 
always replace the luer adapter cap before moving 
the cartridge.

6. Direct the Dionex EluGen cartridge vent line to the rear of the Dionex 
ICS-2100 and snap it onto one of the tubing clips on the rear panel. 

7. Direct the vent line to the waste container and insert it down into the 
waste, gas separator tube about 10 to 15 cm (4 to 6 in).

Vent Plug
(remove)

Luer Adapter

EGC 
Vent Line

Luer Lock
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Recording the Dionex EluGen Cartridge Serial Number in 
Chromeleon 

The serial number is printed on the Dionex EluGen cartridge label.

1. Open the Chromeleon Server Configuration program (click Start on 
the Windows taskbar and select All Programs > Chromeleon > 
>Server Configuration).

2. Double-click the Dionex ICS-2100 system icon. The properties 
dialog box for the Dionex ICS-2100 appears. 

3. Click the Eluent Generator tab (see Figure 91).

4. Select the EGC-1 check box.

5. Enter the Dionex EluGen cartridge serial number and click OK.

Figure 91.  Eluent Generator Configuration Properties: CO3 Example
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Conditioning the Dionex EluGen Cartridge

After completing the installation steps described in the previous sections, 
condition the Dionex EluGen cartridge for 30 minutes before initial use. 

1. Make sure the eluent reservoir is filled with ASTM filtered, Type I 
(18-megohm) deionized water.

2. Verify that the suppressor is off.

3. Verify that the Automatically turn on with pump option is not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page. 
Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

4. On the Dionex ICS-2100 touch screen HOME page, set the pump flow 
rate to 1.00 mL/min.

5. Turn on the pump.

6. On the touch screen HOME page, touch the EGC button to open the 
ELUENT GENERATOR page. Verify that the cartridge type is Carb. 

If the cartridge type is wrong, verify that the cartridge serial number 
was entered correctly in the Chromeleon Server Configuration 
program (see “Recording the Dionex EluGen Cartridge Serial 
Number in Chromeleon” on page 92).

7. Set the EGC-1 concentration to 9 mM.

8. Turn on the EGC-1 current. 

9. Run the Dionex EluGen cartridge at these settings for 30 minutes.

10. Turn off the EGC-1 current.

11. Turn off the pump.

To avoid damaging the suppressor, always turn off the suppressor
before conditioning the Dionex EluGen cartridge. The pump flow is on
during conditioning, however, no flow reaches the suppressor.
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Installing the Dionex EGC CO3 Mixer

Figure 92 illustrates the Dionex EGC CO3 Mixer after installation.

Figure 92.  Dionex ICS-2100 with a Dionex EGC CO3 Mixer Installed
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1. Use a Phillips head screwdriver to 
remove the existing small diameter 
mounting clips from the inside of 
the Dionex ICS-2100 door.

2. Install the larger diameter mounting 
clips (P/N 063642) (see Figure 93).

Figure 93.  Location of Mounting Clips for the Dionex EGC CO3 Mixer

3. Orient the mixer with the outlet 
pointing upward and push it onto the 
clips (see Figure 94). The mixer 
outlet must point upward to ensure 
thorough mixing of the eluent.

4. Locate the 35 cm (14 in) length of 
black PEEK tubing (white labels) 
(P/N 064346). Connect the end 
labeled TO EGC CO3 MIXER IN to the 
mixer inlet.

5. Locate the 60 cm (24 in) length of 
black PEEK tubing (white labels) 
(P/N 064343). Connect the end 
labeled TO EGC CO3 MIXER OUT to 
the mixer outlet.

Figure 94.  Dionex EGC CO3 Mixer Installed on the Dionex ICS-2100 Door
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Filling the Dionex EGC CO3 Mixer with the Carbonate Eluent

Before initial use, follow the steps in this section to fill the Dionex EGC 
CO3 Mixer with the carbonate eluent required for the application to be 
run. Figure 95 illustrates the liquid flow path through the eluent generator 
components during initial filling of the Dionex EGC CO3 Mixer with 
carbonate eluent.

Figure 95.  Plumbing for Filling the Dionex EGC CO3 Mixer with Carbonate Eluent
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1. Connect a 10-32 to 10-32 coupler to the mixer inlet and connect the 
outlet of the yellow PEEK backpressure coil to the coupler.

2. Direct the mixer outlet to the temporary waste container.

3. Verify that the suppressor is off.

4. Verify that the Automatically turn on with pump option is not 
selected on the Dionex ICS-2100 touch screen SUPPRESSOR page. 
Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

5. Set the pump flow rate to the rate required for the application.

6. Turn on the pump.

7. Verify that the system backpressure is between 14 and 16 MPa (2000 
and 2300 psi). If necessary, adjust the pressure by adding or removing 
backpressure tubing.

8. Set the EGC-1 concentration to the value required for your 
application. 

9. Turn on the EGC-1 current.

10. Run at these settings until a consistent flow of eluent is exiting the 
mixer outlet. At a flow rate of 1 mL/min it will take about 16 minutes 
to fill a 4-mm mixer and about 5 minutes to fill a 2-mm mixer.

NOTE The void volume of the 4-mm mixer is about
16 mL. The void volume of the 2-mm mixer is
about 5 mL. 

11. Turn off the EGC-1 current.

12. Turn off the pump.

13. Remove the yellow PEEK backpressure coil from the TO INJ VALVE 

IN - P/ELUENT OUT line and the mixer inlet.

14. Retain the coupler on the mixer inlet.

To avoid damaging the suppressor and Dionex CR-TC, always turn off
the suppressor before conditioning the Dionex EluGen cartridge. The
pump flow is on during conditioning, however, no flow reaches the
suppressor.
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Completing the Eluent Generator Setup for Carbonate Eluent

Figure 96 illustrates the liquid flow path through the Dionex ICS-2100 
after all setup steps are complete and the eluent generator is ready for 
operation.

Figure 96.  Dionex ICS-2100 Flow Schematic: Carbonate Eluent Generation
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1. Connect the TO INJ VALVE IN - P/ELUENT OUT line to the coupler 
attached to the mixer inlet line. Route this line along the back of the 
drip tray to prevent it from being pinched when the Dionex ICS-2100 
door is opened and closed.

2. Route the mixer outlet line to the back of the component panel (see 
Figure 97).

3. Connect the mixer outlet line to port P (2) on the injection valve. 

NOTE Backpressure tubing may be required between the
injection valve and the Dionex EGC CO3 Mixer
outlet. The Dionex EluGen cartridge requires 14 to
16 MPa (2000 to 2300 psi) of system backpressure
for removal of electrolysis gas from the eluent
produced by the cartridge. See Section 19.1 for
details.

4. Go on to Section 19, “Equilibrating the System.”

Figure 97.  Mixer Outlet Routed to the Back of the Component Panel 
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19. Equilibrating the System

1. Turn on the pump and set the flow to the operating rate.

2. Flush the system for about 5 minutes to equilibrate.

3. Monitor the system pressure reading from the Chromeleon Control panel. 

The Dionex EluGen cartridge requires at least 14 MPa (2000 psi) of system 
backpressure for removal of electrolysis gas from the eluent produced by the 
cartridge. A system backpressure of 16 MPa (2300 psi) is ideal. If the pressure 
is too low, install a backpressure coil (see Section 19.1). 

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and 
that the pressure is stable.

5. Monitor the baseline conductivity. In general, it should be <30 S for a system 
set up for anion analyses and <2 S for a system set up for cation analyses. 
Equilibration time varies and it can take some time to reach these expected 
values.

19.1 Dionex EluGen Cartridge Backpressure Requirements

The Dionex EluGen cartridge requires at least 14 MPa (2000 psi) of 
backpressure for optimal removal of electrolysis gas from the eluent 
produced by the cartridge. During system equilibration (see Section 19), 
monitor the system pressure and verify that it is between 14 and 20 MPa 
(2000 and 3000 psi). A system backpressure of 16 MPa (2300 psi) is 
ideal. 

If the pressure is too low, install a backpressure coil between the injection 
valve and the eluent outlet. The backpressure coils listed in the table 
below are included in the Dionex ICS-2100 Ship Kit (P/N 064375). 

The recommended maximum operating pressure for the eluent
generator is 21 MPA (3000 psi). Excessive backpressure may rupture
the tubing in the Dionex EGC degas tubing assembly.
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Connect one end of the backpressure coil to port P (2) on the injection 
valve; connect the other end to the TO INJ VALVE IN - P/ELUENT OUT line 
or to the mixer outlet, if a Dionex EGC CO3 Mixer is installed. 

6. Connect the mixer outlet line to port P (2) on the injection valve. 

NOTE Backpressure tubing may be required between the
injection valve and the Dionex EGC CO3 Mixer
outlet. The Dionex EluGen cartridge requires 14 to
16 MPa (2000 to 2300 psi) of system backpressure
for removal of electrolysis gas from the eluent
produced by the cartridge. See Section 19.1 for
details.

7. Go on to Section 19, “Equilibrating the System.”

20. Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by 
monitoring the pump pressure reading on the IC system panel on the Chromeleon 

Part Number Description Flow Rate Approximate Back-
pressure Added

AAA-053763 4-mm Backpressure Coil 2.00 mL/min 7 MPa (1000 psi)

(red) 1.00 mL/min 3.5 MPa (500 psi)

AAA-053762 4-mm Backpressure Coil 2.00 mL/min 3.5 MPa (500 psi)

(red) 1.00 mL/min 1.75 MPa (250 psi)

053765 2-mm Backpressure Coil 0.50 mL/min 7 MPa (1000 psi)

(yellow) 0.25 mL/min 3.5 MPa (500 psi)

053764 2-mm Backpressure Coil 0.50 mL/min 3.5 MPa (500 psi)

(yellow) 0.25 mL/min 1.75 MPa (250 psi)
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panel tabset (or the touch screen HOME page). Write down the short-term pressure 
fluctuations; they should be less than 0.13 MPa (20 psi).

You can acquire the pressure readings as a separate signal and plot the readings on 
the IC system panel. 

1. Verify that the pump pressure signal is enabled in the Server Configuration 
program:

a. Right-click the IC system device in the timebase and click Properties. 

b. Click the Signals tab.

c. Verify that the Channel_Pressure check box is selected (see Figure 98).

Figure 98.  Pump Pressure Channel Enabled

2. Display the pressure channel plot on the Chromeleon panel:

a. Right-click anywhere on the plot section of the panel.

b. Click Signals. 
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c. Under Available Signals, select Channel_Pressure and click Add >> to 
move the signal to the Displayed Signals list (see Figure 99). Click OK.

Pump pressure readings will now be plotted during data acquisition (along 
with the detector signals).

21. Connecting the Analog Output (Optional)

The analog output connector on the IC system rear panel outputs an analog 
voltage signal proportional to the conductivity measured by the cell. The selected 
data rise time filters the output. The analog output can be connected to an analog-
to-digital converter, such as an integrator or other recording device. Refer to the 
documentation for the device for connection instructions. 

Analog output is 0 to 1V, scaled to the selected range.

The analog output connector on the IC system rear panel outputs an analog 
voltage signal proportional to the conductivity measured by the cell. The selected 
data rise time filters the output. The analog output can be connected to an analog-
to-digital converter, such as an integrator or other recording device. Refer to the 
documentation for the device for connection instructions. 

Analog output is 0 to 1V, scaled to the selected range.

Figure 99.  Online Signal Plot Properties
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For instructions on how to set up the IC system for stand-alone operation with a 
Dionex AS Autosampler, refer to the TTL appendix in the system operator’s 
manual.

22. Pressurizing the Eluent Reservoir (Optional)

The IC system does not require pressurized reservoirs. However, if eluent is 
manually degassed or is sensitive to contamination, Dionex recommends 
pressurizing the reservoir with helium or nitrogen. The air regulator accessory 
bracket and other items needed for pressurizing the eluent reservoir must be 
ordered separately (P/N 060054).

The following required parts must be ordered separately:

• Barbed fitting (P/N 030071)

• Pipe thread reducer (P/N 030087)

• 3-mm (1/8-in) ID tubing (P/N 040793)

• Air regulator accessory (P/N 060054)
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22.1 Connecting the Gas Source

Figure 100 illustrates the eluent reservoir after all gas connections are 
complete.

1. Use the barbed fitting and pipe thread reducer to connect the 3-mm 
(1/8-in) ID tubing to a clean gas source regulated to between 0.55 and 
0.83 MPa (80 and 120 psi).

2. Push the other end of the tubing onto the inlet of the air regulator.

3. Remove the eluent reservoir cap.

4. Connect the gas line from the eluent reservoir cap to the gas line on 
the air regulator outlet.

5. Slip the air regulator accessory bracket over the neck of the eluent 
reservoir (see Figure 100). 

Figure 100.  IC System Pressurized Eluent Reservoir Connections (Optional)
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22.2 Applying the Pressure

1. Before pressurizing, make sure the reservoir is filled and connected to 
the system (see Section 15).

2. Pull out the air regulator knob and turn it fully counterclockwise to 
ensure there is no pressure to the reservoir when the gas source is 
turned on. 

3. Turn on the gas source.

4. Pull out the air regulator knob and turn it clockwise to pressurize the 
eluent reservoir. 

5. Adjust the pressure to between 0.03 and 0.04 MPa (5 and 6 psi). Push 
the regulator knob back in.

Do not pressurize the eluent reservoir above 0.07 MPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über
0,07 MPa aus. 
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23. Connecting the Pump Continuous Seal Wash 
(Optional)

The pump includes a seal wash assembly that can be set up to continuously rinse 
the back of the piston seals to remove salt crystals and prolong the life of the seals. 
Follow the steps below to set up this feature.

Figure 101 shows the seal wash plumbing after all connections are complete.

1. Fill a flush bottle with either deionized water or a combination of deionized 
water and 10% or 20% isopropyl alcohol. (Isopropyl alcohol will inhibit 
bacterial growth in the water.)

2. Place the flush bottle on top of the IC system. During operation, gravity 
maintains flow through the pump heads.

Figure 101.  Piston Seal Wash Flow Schematic
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3. The flush solution is carried to the piston seal wash assembly and out to waste 
via 1.5-mm (0.06-in) ID tubing (P/N 055847). Locate this tubing in the IC 
system Ship Kit and cut the tubing into three unequal pieces in the following 
lengths:

• 117 cm (46 in)

• 152 cm (60 in)

• 15 cm (6 in)

4. Install the tubing as follows (see Figure 102):

a. Push the 117-cm (46-in) piece of clear tubing onto the drain tube on the 
bottom of the secondary pump head. Place the free end of this tubing in 
the flush bottle. Make sure the end of the tubing is near the bottom of the 
bottle.

b. Push the 152-cm (60-in) piece of clear tubing onto the drain tube on the 
top of the primary pump head. This is the waste line. Route this waste line 
through the lower tubing chase and out the back of the IC system.

c. Push the 15-cm (6-in) piece of clear tubing over the drain tube on the top 
of the secondary pump head. Push the other end of the tubing over the 
drain tube on the bottom of the primary pump head.

d. Place a 10 mL syringe (P/N 079803) at the end of the waste line, press the 
syringe against the line to form a seal, and draw out all of the air.

Figure 102.  Primary and Secondary Pump Heads with Drain Tubes
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e. Push approximately 5 cm (2 in) of black 0.25-mm (0.01-in) ID tubing 
(P/N 057057) into the end of the waste line. 

NOTE The black tubing creates a flow restriction.
Assuming a height difference of about 76 cm (30 in)
between the flush bottle and the waste container,
this setup provides a flow of one drop of flush
solution every 5 to 30 seconds. 

f. Place the end of the waste line in a waste container.

g. This completes the piston seal wash installation. Periodically refill the 
flush bottle and empty the waste container as required.

This completes the IC system installation procedure. For operating instructions, 
refer to your IC system operator’s manual. The manual is on the Thermo 
Scientific Reference Library DVD (P/N 053891).

For a brief description of the steps required to begin processing samples using 
Chromeleon, refer to Section 24. For details about using Chromeleon, refer to the 
Chromeleon Help.

24. Sample Processing Overview

You can use Chromeleon to create a sequence of sample injections to be processed 
automatically. 

• For each injection, the sequence includes a program with commands and 
parameters for controlling the IC system and autosampler (if installed) and for 
acquiring sample data. To create a program, click Create Program on the 
Sequence Control panel on the panel tabset. 

• The sequence also includes a quantification method for peak identification 
and area determination. To create a quantification method, select File > New 
and select Method File from the list. 

• To create the sequence, click Create Sequence on the Sequence Control 
panel on the panel tabset. In the sequence, specify the samples to process, the 
names of the program and quantification method that you created, and other 
sample processing parameters (the sample name, sample type, injection 
volume, etc.).



Dionex ICS-2100 Installation Instructions

110 Doc. 065294-03 10/12

• After creating the sequence, you can start sample processing. On the 
Sequence Control panel, click Load Sequence and then click Start Batch.

25. Troubleshooting the USB Configuration Error

Problem: When the IC system power is turned on for the first time, a Windows 
message box appears asking for a USB configuration file (cmwdmusb.inf). 

Possible Cause: The USB cable was connected and the power turned on before 
Chromeleon was installed.

Solution: 

Follow these steps to resolve the problem:

1. Click Cancel in the Windows message box. 

2. Turn off the power to the USB device and unplug the USB cable from the 
computer. 

3. Install Chromeleon (see Section 6).

4. Reconnect the USB cable to the computer and turn on the power to the 
device. Windows will now automatically recognize the USB device.
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